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CHAPTER 2 The Basic Financial 

Statements

Much of financial analysis takes as its starting point the basic financial statements of the

firm. It is therefore crucial that the analyst have a strong fundamental understanding of these

statements. There are three basic financial statements: 

1. The income statement summarizes the results of the firm’s operations over

a period of time. The income statement tells us the total revenues and

expenses for the time period and also contains several different measures

of the accounting profits earned by the firm. Typically, income statements

are prepared for different time periods, usually monthly, quarterly, and

annually.

After studying this chapter, you should be able to:

1. Explain the purpose and understand the format of the firm’s three basic financial

statements: the income statement, the balance sheet, and the statement of cash

flows.

2. Construct each of these statements in Excel with data for any company.

3. Link worksheets together so that formulas in one worksheet can reference data

in another and update automatically when changes are made.

4. Use Excel’s Outline tool to selectively display or hide parts of a financial statement. 
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2. The balance sheet describes the assets, liabilities, and equity of the firm at

a specific point in time. Assets are the (tangible or intangible) things that a

firm owns. Liabilities are the firm’s debts. Equity is the difference

between what the firm owns and what it owes to others. Because the

balance sheet is specific to a point in time, it is much like a photograph.

What it shows was true when the snapshot was taken, but is not

necessarily true when it is viewed.

3. The statement of cash flows outlines the sources of the firm’s cash inflows

and shows where the cash outflows went. Activities that bring cash into

the firm are referred to as sources of cash, while those that take cash out of

the firm are referred to as uses of cash.

In this chapter, we will build each of these three statements for Elvis Products International,

a small producer of Elvis memorabilia. Each financial statement will be created in its own

worksheet in the workbook, and we will create links between the sheets as necessary. Before

beginning, open a new workbook.

The Income Statement

The income statement is a fairly simple document that begins by listing a firm’s revenues

(perhaps by sources or in total) followed by all of the firm’s expenses. The result of the

income statement is the net income for the period. Net income represents the accounting

profit left over after all expenses and taxes have been paid from the revenue for the period.

Building an Income Statement in Excel

Exhibit 2-1 presents the income statement for Elvis Products International (EPI) for the year

ending December 31, 2011. We will build this income statement first and then use it as a

base for creating the 2010 income statement.

While we are building the income statement, we want to keep a couple of general principles

in mind. Principle 1 says that we want to make Excel do as much of the work as possible.

Any time a value can be calculated, we should use Excel to do so. The reasoning behind this

principle is that we want to avoid mistakes and increase productivity. A little thought before

beginning the design of a worksheet can help minimize data entry errors and increase

productivity by reducing the amount of data that needs to be entered. 

Principle 2 says that we should format the worksheet in such a way as to make it easy to

comprehend. There are many times that you will create a worksheet for others to use or for

your own use at a later date. 

Principle 1: 

Make Excel do  as much

 of
 

the work as possible. 

Whenever possible, a 

formula should be used 

rather than entering 

numbers. In the long run 

this will minimize errors.

Principle 2:

Format the worksheet so 

that it is easy to understand. 

Borders, shading, and font 

choices are more than just 

decorations. Properly 

chosen, they can make 

important numbers stand 

out and get the attention 

they deserve.
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EXHIBIT 2-1

EPI’S INCOME STATEMENT FOR 2011 AND 2010

Properly organizing the data and the judicious use of color and fonts can make the worksheet

easier to use and modify.1 Worksheets that are disorganized and sloppily formatted do not

engender faith in their results.

It is usually helpful when working with multiple worksheets in a workbook for each sheet to

be given a name other than the default. Worksheets can be renamed using the Format button

on the Home tab or by right-clicking the sheet tab. Right-click “Sheet1,” choose Rename,

and then type Income Statement over the existing name. This step is important because

when we later begin referencing data on this sheet, the references will require the name of

the sheet in addition to the cell reference. Note, however, that you can always rename the

sheet later and any formulas referencing it will automatically be updated.2

1. We would like to emphasize the word “judicious.” Some people overuse fonts and end up
producing documents with a definite ransom note appearance. Do yourself, and others, a favor by
limiting your use of fonts to one or two per document.

2. This is always true for references within the same workbook. However, suppose that we have two
workbooks called X and Y. If X contains a reference to a cell in Y, it will be updated automatically
as long as both workbooks are open. If X is closed when the sheet name is changed in Y, then you
will see a #REF! error the next time you open X and will have to manually change the reference.
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We will begin building the income statement with the titles in A1:A3. Remember, if the need

arises, we can always insert new rows or columns into the worksheet at a later time. In A1

type: Elvis Products International; in A2: Income Statement; in A3: For
the Year Ended Dec. 31, 2011. The first line of the title identifies the company, the

second identifies the type of statement, and the third identifies the time period that the

statement covers. Now center the titles by selecting A1:C3, choose Format Cells, select the

Alignment tab, and then select “Center Across Selection” under Horizontal. Note that Excel

provides an icon in the Alignment group of the Home tab that is titled “Merge and Center” and

accomplishes a similar alignment. However, in addition to centering the titles over the selected

columns it also merges the cells into one. This sometimes creates a problem if we later decide

to insert a new column. In general, you should never use the Merge and Center icon.

How to proceed from this point is largely a matter of preference. We could move line by line

through the income statement, entering a label followed by the value. An alternative is to

enter all of the labels and then all of the numbers. The second method seems preferable at

this point so that we may concentrate on the numbers. The labels are going to be in column A

and the numbers in column B. It is good practice to enter a label indicating the end of the

period above the data, so move to B4 and type: 2011. 

Beginning in A5, enter the labels exactly as they appear in Exhibit 2-1. Once you have

entered the labels, it is likely that you will find that some of these labels are too long to fit in

only one cell. To remedy this problem, we need to change the width of column A. There are

several ways to accomplish this in Excel. The slowest method is to select a cell in column A

and then click the Format button on the Home tab. Next, choose Column Width and enter:

30 in the edit box. If you are using some font other than 12 point Times New Roman, you

will have to experiment with different numbers to find the appropriate width for the column.

Alternatively, instead of entering a specific number for the column width, we can also let

Excel determine the appropriate width. Select column A, and click the Format button. Now

choose Autofit Column Width and Excel will automatically make the column wide enough

to accommodate the longest text in the column.

As usual, there is a shortcut available. If you slowly move the mouse pointer over the

column headers, you will notice that the pointer changes its shape (to that pictured at left)

as it passes over the boundary between columns. Press the left mouse button while the

pointer is over this boundary and drag until the column is wide enough to accommodate the

text. You can also double-click on the column boundary and Excel will set the column

width to the best fit for the data. Each of these techniques can also be used to change the

height of a row.

When entering data for large companies, it is often preferable to display the numbers in

thousands or millions of dollars, rather than the full amount. For EPI, we will enter the

numbers in full precision and later apply a custom number format. Move to B5 and enter:

3,850,000.3 Keeping principle 2 in mind, we would like the numbers to display with
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commas and no decimal places. Because each cell can maintain a number format, regardless

of whether it contains any numbers, we will pre-format the cells that we are going to use.

Select cells B5:C15 and click the Comma Style button in the Number group. Now click the

Decrease Decimal button twice so that no decimal places are displayed. When we enter

numbers into these cells, they will automatically take on the format that we want.

Move to B6 and type: 3,250,000 for cost of goods sold. This is the total cost of the

products sold to customers, including inventory shrinkage and write-downs for damaged or

outdated products. Notice that, as promised, the number in B6 appears with commas. 

Gross profit is the amount left over after paying for the goods that were sold. To calculate

gross profit, we subtract cost of goods sold from sales. Again, we want Excel to make all of

the calculations, so in B7 type: =B5-B6. Selling, general and administrative (SG&A)

expense is an input, so enter: 330,300 in B8. Fixed expenses (rent, salaries, etc.) for the

period are an input, so enter: 100,000 in B9. Depreciation is also an input in this case, so

in B10 enter: 20,000. 

Earnings before interest and taxes (EBIT) is gross profit less all remaining expenses other

than interest and taxes. Any of several formulas could be used for this calculation, for

example the obvious formula for EBIT in B11 is: =B7-B8-B9-B10. However, obvious

formulas aren’t always the best. We could simplify this equation somewhat by making use of

the SUM function. The new formula would be: =B7-SUM(B8:B10). SUM is a built-in

Excel function that returns the summation of the arguments. SUM is defined as:

SUM(NUMBER1, NUMBER2, …)

where NUMBER1 is the first number (or cell address), NUMBER2 is the second, and so on. Excel

will also accept ranges in place of any individual cell reference. There are two advantages of

using the SUM function in this case: (1) It is faster and more compact; and (2) the range will

automatically expand if we insert a new row. The second advantage is the most important. If

we add another category of expense by adding another row above row 9, for example, our

formula would automatically incorporate the new row by changing to: B7 – Sum (B8:B11). If

we used the original formula, we would have to remember to change it after adding the new

row.

SUM is one of the more commonly used built-in functions, so common that Microsoft has

included the AutoSum button (pictured at left) in the Editing group on the Home tab to

automate the summation of rows or columns of numbers. To use the AutoSum button,

simply select the cell where you want the formula to be placed and then click the button. Or,

3. There is no need for you to type the commas. We are showing them here for clarity. However, Excel
will accept the numbers with commas if you wish to type them in. If you don’t enter them, then you
will need to apply a number format that includes commas.
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you can use the Alt+= keyboard shortcut. Excel will make an intelligent guess about which

cells you want included, and it is usually correct. If it guesses wrongly, merely select the

range you wish to include and Excel will make the change. Note that the AutoSum button

doesn’t work when you are editing a formula in the formula bar.

The AutoSum button has proved so popular that its functionality has been improved. If you

click the little arrow to the right of the AutoSum button, it will drop down a list of alternative

functions. Now you can more quickly use the AVERAGE, COUNT, MAX, or MIN functions just

by choosing a function from the menu.

In B12 enter 76,000 for the interest expense. Next, we will calculate earnings before taxes

with the formula: =B11-B12 in cell B13. EPI pays taxes at the rate of 40% on taxable

income, so in B18 type 40%. We will calculate the dollar amount of taxes in B14 with:

=B13*$B18. Note that this lets us easily change the tax rate without having to edit

formulas. Finally, net income is the profit earned by the firm after all revenues and expenses

have been taken into account. To calculate net income, enter =B13-B14 in cell B15. 

As you can see, EPI’s net income for the fiscal year 2011 was $44,220. However, for

analysis purposes, we normally are not overly concerned with net income. Net income does

not accurately represent the funds that a firm has available to spend. In the calculation of net

income, we include depreciation expense (and/or other noncash expenses such as depletion

or amortization), which ostensibly accounts for the decline in the value of the long-term

assets of the firm. Because nobody actually wrote a check for the depreciation expense, it

should be added back to the net income number to give a better, though not complete, picture

of the cash flow for the period. Cash flow is the number one concern for financial analysts.

Creating EPI’s income statement for 2010 doesn’t take nearly as much work. First, select

B4:B15 and copy the cells using the Copy button on the Home tab. Select C4 and click the

Paste button. Don’t forget to change C4 to: 2010. Now you have an exact copy of the 2011

income statement. Enter the numbers from Table 2-1 into the appropriate cells.

TABLE 2-1

EPI’S 2010 INCOME AND EXPENSES

Category Value

Sales 3,432,000

Cost of Goods Sold 2,864,000

SG&A Expenses 240,000

Depreciation Expense 18,900

Interest Expense 62,500
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Notice that you only had to enter the new numbers. The formulas are updated and

recalculated automatically. So instead of entering 11 cells of formulas or numbers, you only

had to enter six numbers and no formulas at all. Your worksheet should now resemble the

one in Exhibit 2-1, page 45.

The layout of the income statement that we have seen is the one normally used by analysts

outside the firm. Those inside the firm will have more information and may find that Excel’s

Outline display will make the worksheet easier to understand and maintain. To learn about

outlining, see page 62.

The Balance Sheet

The balance sheet is usually depicted in two sections: the assets section at the top or left side,

and the liabilities and owner’s equity section at the bottom or right side. It is important to

realize that the balance sheet must balance (thus the name). That is, total assets must equal

the sum of total liabilities and total owner’s equity. Each of these sections is usually further

divided into subsections.

On the asset side, there are two subsections. The current assets section describes the value of

the firm’s short-term assets. Short-term, in this case, is defined as one year or the time it

takes for the asset to go through one cash flow cycle (i.e., from purchase to sale to

collection). Typical current assets are cash, accounts receivable, and inventories. Fixed

assets are those assets with lives longer than one year. Examples of fixed assets include

vehicles, property, and buildings. 

Like assets, liabilities can be subdivided into two sections. Current liabilities are those

liabilities that are expected to be retired within one year. Examples are items such as

accounts payable and wages payable. Long-term liabilities are those that will not be paid off

within the current year. Generally, long-term liabilities are made up of various types of

bonds, bank loans, and so on.

Owner’s equity represents the difference between the value of the total assets and liabilities

of the firm. This part of the balance sheet is subdivided into contributed capital and retained

earnings. Contributed capital is the investment made by the common and preferred

stockholders of the firm. Retained earnings is the accumulation of the undistributed profits

of the firm.

Building a Balance Sheet in Excel

The process of building a balance sheet in Excel is very similar to building the income

statement. EPI’s 2011 and 2010 balance sheets, as shown in Exhibit 2-2, will serve as an

example.
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We will keep EPI’s balance sheets in the same workbook, but on a different worksheet, as

the income statement. Keeping related data in the same workbook allows for easy

referencing. Using separate worksheets allows us to keep the worksheets uncluttered and

makes it easier to design the worksheets. Click on the Sheet2 tab with the right mouse button

and select Rename from the menu. Type Balance Sheet as the new name for this

worksheet.

Enter the labels from Exhibit 2-2 into the blank worksheet. Notice that many of the labels in

the balance sheet are indented. There are two ways to accomplish this effect. The method

that we usually use, and are using here, is to first type the text into the cell and then click the

“Increase Indent” button (pictured at left) in the Alignment group of the Home tab.

An alternative method would be to insert the indented labels into column B instead of

column A. This way, by controlling the width of column A, we could control the depth of the

indentation. The labels in column A will simply overlap into column B as long as there is no

text in the cell to the right. However, this method can cause problems if a new column is

inserted between A and B, so the increase indent button method is a better choice.

In EPI’s balance sheet, nearly everything is a direct input so we won’t discuss every cell. The

italicized entries are formulas that we will discuss for 2011. The formulas for the 2010

balance sheet can be copied from the 2011 balance sheet. As with the income statement, you

should enter the numbers as shown and apply the same number format. 

In the asset section, the first formula is for total current assets in B8. This is simply the sum

of all of the current asset accounts, so the formula is: =SUM(B5:B7). Next, we calculate

EPI’s net fixed assets. This is equal to plant and equipment less accumulated depreciation, so

in B11 enter: =B9-B10. Finally, calculate total assets by adding the current assets and net

fixed assets with the formula: =B8+B11. 

The liabilities and owner’s equity section is similar. We will calculate several subtotals and

then a grand total in B23. Total current liabilities in B17 is calculated with:

=SUM(B14:B16). Total liabilities is calculated with the formula: =B17+B18 in B19.

Total shareholder’s equity is calculated in B22 with: =B20+B21. And, finally, we calculate

the total liabilities and owner’s equity in B23 with: =B19+B22. Copy these formulas into

the appropriate cells in column C and enter the numbers from Exhibit 2-2 to create the 2010

balance sheet. 
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EXHIBIT 2-2

EPI’S BALANCE SHEET

To achieve the underlining and shading effects pictured in the exhibits, select the cells and

then choose Format Cells from the shortcut menu and then click on the Border tab. To set the

type of border, first click on the line style on the left side of the dialog, and then click on the

location of the line in the Border area of the dialog. If you want to shade the selection, click

on the Fill tab and then select the color and pattern for the shading. It is usually best to make

the text in a shaded cell bold so that it can be clearly seen. Before continuing, make sure that

your worksheet looks like the one in Exhibit 2-2.

Improving Readability: Custom Number Formats

When the dollar amounts on a financial statement are very large they can be a little

confusing and hard to read. To make the numbers easier to read, we can display them in

thousands of dollars using a custom number format. For example, EPI’s sales for 2011 were

3,850,000. We can apply a custom number format that will display this amount as 3,850.00.

This is commonly done in annual reports or any other report that lists large dollar amounts.



CHAPTER 2: The Basic Financial Statements

52

EXHIBIT 2-3

THE INCOME STATEMENT WITH A CUSTOM NUMBER FORMAT

Return to the Income Statement worksheet and select B5:C15. To create the custom number

format, choose Format Cells from the shortcut menu. On the Number tab, choose the

Custom category. This will allow us to define our own number format. We can begin by

choosing a predefined number format. Here we will choose the “#,##0.00” format from the

list. If we add a comma after the format, Excel will display the numbers as if they have been

divided by 1,000. Two commas would display the number as if they had been divided by

1,000,000, and so on. In the Type edit box add a single comma after the chosen format so

that it looks like “#,##0.00,”. You will see an example of what your formatted numbers will

look like in the Sample area of the dialog box. The numbers that you have entered will

appear to have been divided by 1,000, but this affects only the appearance of the numbers.

You should always enter the full number and then format it to look the way that you wish.

The manner in which Excel displays numbers will not affect any calculations. Regardless of

the format, numbers are always saved with full precision. The format only changes what we

see on the screen, not what is kept in memory. To see the full number, select the cell and look

in the formula bar. 

Before continuing, edit cell A3 so that it says: For the Year Ended Dec. 31, 2011 ($
in 000's). This will allow anyone looking at your worksheet to instantly understand that

the numbers are displayed in thousands of dollars. Your income statement should now look

like the one in Exhibit 2-3.
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Because the income statement has been reformatted, it makes sense to use the same number

format on the balance sheet for consistency. Switch to the Balance Sheet worksheet and

select cells B5:C23 (see Exhibit 2-2, page 51). Now, choose Format Cells and go to the

Custom category. Select the format that you just created from the list (it should be at the

bottom of the list). Finally, change the title in A3 so that it indicates that the dollar amounts

are shown in thousands. Your balance sheet should now look like the one in Exhibit 2-4.

EXHIBIT 2-4

THE BALANCE SHEET WITH A CUSTOM NUMBER FORMAT

Creating your own number formats in Excel is easy, if you understand a few key points. The

number format code is a series of wildcard characters. Both the # sign and 0 work as a stand-

in for any digit. The difference between them is how leading and trailing zeros to the right of

the decimal point are handled. The # sign will not display leading or trailing zeros, while 0

will. Generally, use # signs to the left of the decimal point and 0 to the right. For example, to

display 1542.2 with a thousands separator and two decimal places, we might use a format

code of “#,###.00” and see 1,542.20. If we left off the last 0 in the code, the result would be

1,542.2 (notice that the trailing zero is missing). If some of your numbers will be less than

one, then using “#,##0.00” would be better because that will preserve the zero to the left of

the decimal point.
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Custom formats can do many other tricks. You can add color, have different formats for

positive and negative numbers, and add text. To learn more about creating custom formats

search for “create or delete a custom number format” in the online help.

Common-Size Financial Statements

A technique widely used by financial analysts is to examine common-size financial

statements, which display the data not as dollar amounts, but as percentages. These

statements provide the analyst with two key benefits:

1. They allow for easy comparisons between firms of different sizes.

2. They can aid in spotting important trends which otherwise might not be

obvious when looking at dollar amounts.

As we’ll see, common-size financial statements are easy to create and make it simple to

glean important insights that are not immediately obvious when looking at dollar amounts.

Creating Common-Size Income Statements

A common-size income statement is one that shows all of the data as a percentage of the

firm’s total revenues. Before beginning, remember that we want to make full use of Excel’s

capabilities to be as productive as possible. Instead of creating a new, blank worksheet and

re-typing all of the labels, we will make a copy of the Income Statement worksheet. Right-

click on the sheet tab and choose Move or Copy… from the shortcut menu. To create a copy,

be sure to click on “Create a copy” at the bottom of the dialog box. Note that the copy can be

placed anywhere in the current workbook, in a new workbook, or any other open workbook.

Place it before the Balance Sheet workbook. Right-click on the sheet tab and rename the

worksheet to Common-size Income Statement. 

We now have a perfect copy of the income statement that we can convert into a common-

size income statement. The formulas that we use will reference data from the Income

Statement worksheet, so it is helpful to understand how these references are created. In order

for Excel to know where to get the data it has to be told the location and name of the file, the

name of the worksheet, and the cell address. For example, a reference to a cell in another

workbook would look like the following:

=C:\[Filename.xlsx]Sheet1!A1

Notice that the path to the file is listed first, then the name of the file is in brackets. This

allows Excel to find the file on your computer. The file name is followed by the name of the

worksheet, then an exclamation point, and then the cell address. If the path, file name, or

worksheet name contains spaces, then everything after the equals sign and before the
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exclamation point will be enclosed in single quotes. Fortunately, you won’t have to type all

of this. Instead, just type an equals sign and then switch to the appropriate worksheet and

click on the cell you want to reference. Excel will fill in all of the details. If the data in the

original worksheet changes, then the data will be updated automatically in the worksheet

with the reference.

We can now create the common-size income statement with only two simple changes. First,

in B5 type = and then switch to the Income Statement worksheet. Now click on B5 and type

/ and then click on B5 again. Finally, press the Enter key and your formula will be:

='Income Statement'!B5/'Income Statement'!B5. Now, change the number

format to a Percentage format with 2 decimal places. You should now see that the result is

100.00%. 

We are going to copy that formula to every cell in the income statement, so we need to use a

mixed reference (see page 18) in the denominator so that it will update appropriately.

Therefore, you will need to edit the reference in the denominator so that it will always

reference row 5. Change the formula by adding a $ before the 5, so that it becomes:

='Income Statement'!B5/'Income Statement'!B$5.

At this point, we want to copy this formula to every other cell in the worksheet. However, if

we do a normal copy and paste, our underline formatting will be destroyed. To get around

this problem, copy the cell and then select all of the other cells (B6:C15 and C5). Now,

instead of pasting, choose Paste Special from bottom of the Paste menu on the Home tab. As

shown in Figure 2-1, this allows us to choose exactly what and how to paste the data. In the

list of options, choose Formulas and number formats.

FIGURE 2-1

THE PASTE SPECIAL DIALOG BOX

You have now created a common-size income statement with a minimum number of steps. It

should resemble the one shown in Exhibit 2-5. You can easily see why this is a useful tool

for analysts. At a glance, you can see that Cost of Goods Sold has risen by about 1% and that



CHAPTER 2: The Basic Financial Statements

56

Selling and G&A expenses has risen by about 1.5% in 2011 relative to sales. Also, looking

at row 15 instantly shows that the firm’s net profit margin (see page 119) has decreased by

more than half. This technique also makes for easy comparisons to other firms or to an

industry average income statement.

EXHIBIT 2-5

EPI’S COMMON-SIZE INCOME STATEMENTS

Creating a Common-Size Balance Sheet

The common-size balance sheet can be created just as we did for the income statement. The

only difference is that the balance sheet entries are displayed as a percentage of the firm’s

total assets instead of total revenues. 

To make the common-size balance sheets for EPI, proceed in the same manner as for the

common-size income statements. Create a copy of the existing Balance Sheet worksheet,

and rename the sheet to Common-size Balance Sheet. In B5 enter: ='Balance
Sheet'!B5/'Balance Sheet'!B$12. That will calculate the cash balance as a

percentage of total assets. We want to do the same for every item, so copy the formula and

then select all of the cells on the balance sheet. Use Paste Special to paste only the Formulas

and number formats. Your common-size balance sheet should look like the one in Exhibit 2-6.
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EXHIBIT 2-6

EPI’S COMMON-SIZE BALANCE SHEET

Building a Statement of Cash Flows4

Boiled down to its essence, a firm participates in two kinds of financial transactions: those

that increase the cash balance (cash inflows, or sources of funds) and those that decrease the

cash balance (cash outflows, or uses of funds). 

One way that a financial analyst can determine how well a firm’s management is performing

is to examine how they are managing the shareholder’s money. The accounting profession

has developed the Statement of Cash Flows, which is useful for this type of analysis. The

4. We present the “indirect method” of constructing the statement of cash flows because this method is
used by most companies. As of this writing, there are ongoing discussions that may ultimately
require that the direct method be used. These discussions may also result in a requirement that a
“reconciliation schedule” be provided to reconcile the income statement and the statement of cash
flows.
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statement of cash flows summarizes the causes of changes in the firm’s cash balance.

Changes in the cash balance can be determined as follows:

The statement of cash flows is organized into three sections according to how the cash flows

were generated. The first section is “Cash Flows from Operations,” which describes the cash

flows generated by the firm in the ordinary course of conducting its business. The next

section, “Cash Flows from Investing,” describes cash flows due to the firm altering its mix

of fixed assets. The final section, “Cash Flows from Financing,” describes the cash flows

generated in the course of financing the firm.

The most obvious source of operating cash flow is sales and other revenues. Similarly, the

most obvious uses of cash are the firm’s expenses. However, we already have this

information on the income statement and don’t need to repeat it in the statement of cash

flows. Therefore, instead of putting nearly the entire income statement into the Cash Flows

from Operations section, we will only enter net income, which is a summary of the entire

income statement. In addition, we will add back the depreciation expense (and other noncash

charges) because, in reality, there was no cash outflow associated with depreciation. The rest

of the entries on the statement of cash flows will be changes in balance sheet items, though a

few will be left out for reasons that we will discuss later.

Unlike the income statement and balance sheet, which are mostly exercises in data entry, the

statement of cash flows is primarily composed of formulas. Because these formulas

reference many different cells in the workbook it is generally easiest to use Excel’s pointer

mode when entering them. To begin, insert a new worksheet and rename it to Statement
of Cash Flows. Enter the labels as shown in Exhibit 2-7 and then apply our custom

number format to the cells in B5:C21.

TABLE 2-2

DETERMINING THE CHANGE IN THE CASH BALANCE

Beginning Cash Balance

+ Cash inflows (sources)

– Cash outflows (uses)

= Ending Cash Balance



59

Building a Statement of Cash Flows

EXHIBIT 2-7

STATEMENT OF CASH FLOWS FOR EPI

The first two items under Cash Flows from Operations are Net Income and Depreciation

Expense. As previously mentioned, these are unique items because they are the only ones on

the statement of cash flows that come from the income statement and are also the only items

that are not represented as changes from a previous period.5 Also realize that Net Income

summarizes every other item on the income statement. Therefore, if we were to include

Sales, for example, we would be double counting. To enter the net income first type an = in

B5 and then (before pressing the Enter key) click on the sheet tab for the Income Statement.

Excel will change to the worksheet containing the income statement. Now click on B15 and

press Enter. At this point, Excel will switch back to the Statement of Cash Flows worksheet

and your formula in B5 should read: ='Income Statement'!B15. This formula directs

Excel to pull the value from cell B15 on the Income Statement worksheet into B5. If we

change some values in the income statement, any change in net income will automatically be

reflected in the statement of cash flows. 

5. Actually, we could calculate depreciation expense as the change in accumulated depreciation.
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We can actually make referencing other sheets slightly easier if we display two or more

sheets on the screen at once. We will use this technique to complete the statement of cash

flows.

First, switch to the Income Statement sheet and then click the New Window button on the View

tab. This will open a second copy of the workbook. Click the Arrange All button and then choose

Horizontal from the dialog box. You should now see two identical copies of the workbook. In one

of the copies, click on the sheet tab for the Statement of Cash Flows. In B6, type = and then click

anywhere on the income statement. Now scroll down so that cell B10 is visible and click on it and

press the Enter key. The formula in B6 of the Statement of Cash Flows should read: ='Income
Statement'!B10, and the value should be 20,000. If you didn’t already apply the custom

number format that we used on the income statement, then you will need to apply it now. Select

B5:C21 and then select Format Cells from the right-click menu and apply the same custom format.

Alternatively, you can click on any cell in the Income Statement worksheet and then click the

Format Painter icon on the formatting toolbar (pictured at left) to copy the format. Now, select

B5:C21 on the Statement of Cash Flows worksheet to paste the format. Regardless of the method

you use, the value in B6 will be displayed as 20.00, though the actual value in the cell is 20,000.

The rest of the statement of cash flows can be completed in a similar manner. Because we

are done with the income statement, we now want to display the balance sheet in that

workbook. Click on the sheet tab labeled Balance Sheet. You should now have both the

Statement of Cash Flows sheet and the Balance Sheet displayed. 

At this point, we must be careful with respect to the signs of the numbers entered into the

statement of cash flows. In general, when an asset increases that represents a cash outflow

(i.e., a use of funds). An asset that decreases represents a cash inflow (i.e., a source of

funds). Liability and equity items are exactly the opposite. We represent uses of funds as

negative numbers and sources of funds as positive numbers on the statement of cash flows.

Table 2-3 shows how to always get the sign correct. As an example, EPI’s accounts

receivable balance increased from $351,200 in 2010 to $402,000 in 2011. Because the firm

invested in accounts receivable by making more loans to customers, it represents a use of

funds and should be indicated with a negative sign on the statement of cash flows. On the

TABLE 2-3

SIGNS OF CASH FLOWS FOR THE STATEMENT OF CASH FLOWS

Direction of Change Order of 

SubtractionType of Item Increase Decrease

Asset – + Older – Newer

Liability or Equity + – Newer – Older
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other hand, the accounts payable balance increased and, because it is a liability, represents a

source of funds. It will have a positive sign on the statement of cash flows.

The formula for the change in accounts receivable in B7 should be: ='Balance
Sheet'!C6-'Balance Sheet'!B6 . Because it is an asset, we are subtracting the

newer value from the older value as shown in Table 2-3. The change in inventories can be

found by simply copying this formula down to B8. For liability and equity items the

direction of the subtraction will be reversed. This will ensure that the sign is always correct

no matter how the numbers change.

The formula to calculate the change in accounts payable in B9 is: ='Balance
Sheet'!B14-'Balance Sheet'!C14. In B10, to get the change in other current

liabilities, we use the formula: ='Balance Sheet'!B16-'Balance Sheet'!C16.

Now we calculate the total cash flows from operations in C11 with: =SUM(B5:B10). Note

that we have skipped over the short-term notes payable. That is because notes payable is not

an operating current liability. Generally, any interest-bearing liability is included in the Cash

Flows from Financing section.

If you are paying close attention, then you probably noticed that we haven’t included the

change in the cash balance in this section. The reason is that the change in the cash balance is

the final result of the statement of cash flows. We will calculate that by summing the

subtotals from each of the three sections (see C21 in Exhibit 2-7). Remember, the purpose of

the statement of cash flows is to explain the actions that resulted in the new cash balance, so

including the change in cash would be double counting.

Cash flows from investing are those cash flows generated from investments (or dis-

investments) in long-term assets. In the case of EPI, that means plant and equipment.6 This

change can be calculated in B13 by the formula: ='Balance Sheet'!C9-'Balance
Sheet'!B9. For consistency, we will calculate the total cash flows from investing in C14

with: =B13. 

For the final section, our first item is the change in notes payable. This item increased from

$200,000 in 2010 to $225,000 in 2011, representing a cash inflow of $25,000. In B16 enter

the formula: ='Balance Sheet'!B15-'Balance S heet'!C15. Next, we can

calculate the change in long-term debt with the formula: ='Balance Sheet'!B18-
'Balance Sheet'!C18. Even though common stock didn’t change during the year, it is

a good idea to include it. In B18, enter: ='Balance Sheet'!B20-'Balance
Sheet'!C20.

6. Note that we do not use Net Fixed Assets, as that would result in double-counting depreciation
expense.
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Cash dividends paid to shareholders in 2011 were $22,000. This is calculated with the

formula:

Dividends paid are always a use of funds so in B19 enter the formula: =-('Income
Statement'!B15-('Balance Sheet'!B21-'Balance Sheet'!C21)). Note

that the parentheses are important in this case and that the result should be –22,000. Again,

we can total the cash flows from financing in C20 with: =SUM(B16:B19). 

Finally, in C21 we calculate the net change in the cash balance by adding up the subtotals, so

the formula is: =SUM(C11:C20). Note that this should exactly equal the actual change in the

cash balance from 2010 to 2011, otherwise you have made an error. The most common errors

are likely to be either a wrong sign or an omitted item. 

Because you no longer need the second copy of the worksheet, you may close either copy by

clicking the Close button in the upper right corner of the window. Choosing Close from the

File tab would also work, but that will close both copies. Note that if you save the workbook

with more than one view, it will retain that setting and both views will be visible when you

reopen the workbook. 

Before continuing, make sure that your worksheet resembles that pictured in Exhibit 2-7 on

page 59.

Using Excel’s Outliner

Most people were first introduced to outlining as a tool to help organize a paper by

considering the major ideas first and progressively moving to the details. Excel’s outliner

works similarly, except that it is not really a tool for organizing ideas, but a tool to show or

hide whatever level of detail is appropriate in a spreadsheet. It is reminiscent of the

“directory tree” that is used in Windows Explorer for browsing through directories.

Excel can automatically build an outline based on the formulas that you have entered. It

looks for cells that summarize information in other cells and considers those to be top level.

For example, consider the statement of cash flows that we created in Exhibit 2-7. Once an

outline is applied to this sheet, we can collapse it so that it appears like the screen fragment

in Exhibit 2-8.

Dividends Paid Net Income Change in Retained Earnings–=
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EXHIBIT 2-8

STATEMENT OF CASH FLOWS WITH ONLY LEVEL 1 DISPLAYED

Excel is sometimes smart enough to apply an outline automatically, but we will do it

manually to get exactly the result that we want. Select A4:C10 on the Statement of Cash

Flows worksheet and then press Shift+Alt+Right arrow (or click the top half of the Group

button on the Data tab). In this case we want to group by rows, so just press Enter when the

dialog box appears. You will see an outline symbol appear at the left of the selected cells. If

you click on the symbol, the outline will collapse so that it shows only the summary cell.

Clicking the outline symbol again will restore the display. To create the other parts of the

outline, select A12:C13 and A15:C19 and repeat the above steps for each range. If you make

a mistake or decide that you don’t like the outline feature, you can clear the outline by

clicking the lower half of the Ungroup button and choosing Clear Outline from the menu.

Outlining is especially useful for presentations to people who don’t need to see all of the

details. It frees you from creating a separate summary worksheet. For example, we could

create an outline of an income statement. Suppose that the income statement worksheet that

we use inside the firm contains a breakdown of sales by product, several categories of cost of

goods sold, and so on. When we need to provide the income statement to those outside the

firm we may not wish to provide all of that detail. Instead, simply print a copy from the

outline with the appropriate level of detail. Note that if you print an outlined worksheet, only

the levels displayed on-screen will print. However, if you copy an outlined worksheet, all of

the details will be copied and will be visible to anybody who has the copy. 

Distributing workbooks with “hidden” data has been the source of many embarrassing, and

potentially costly, stories. For example, a lawyer working for Barclays Capital on its

agreement to purchase some of the assets of Lehman Brothers reformatted a worksheet and

accidentally exposed 179 hidden rows before creating a PDF file for submission to the
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bankruptcy court. Those previously hidden rows contained information regarding contracts

that Barclays did not want to purchase, but that were inadvertently included in the offer.7

Excel 2010 has a feature designed to avoid this and similar errors. Before distributing a

workbook use the Inspect Document feature to search for and remove, if necessary, hidden

data. This feature can be found in the Info tab under the File tab. Click the Check for Issues

button and choose Inspect Document.

Summary

In this chapter, we discussed the three primary financial statements: the income statement,

the balance sheet, and the statement of cash flows. You should have a basic understanding of

the purpose of each of these statements and know how to build them in Excel.

We demonstrated how worksheets can be linked so that formulas in one worksheet can

reference data on another sheet. Custom number formatting was introduced, and we saw

how outliner can be a useful tool for selectively displaying or hiding data. 

Make sure that you have saved a copy of the EPI workbook because we will be making use

of this data in future chapters.

7. See http://abovethelaw.com/Barclays Relief Motion.pdf.

TABLE 2-4

FUNCTIONS INTRODUCED IN THIS CHAPTER

Purpose Function Page

Total numbers or a 

range of numbers

SUM(NUMBER1,NUMBER2, . . .) 47

http://abovethelaw.com/BarclaysReliefMotion.pdf
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Problems

1. Using the data presented below:
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a. Recreate the income statement and balance sheet using formulas

wherever possible. Each statement should be on a separate worksheet.

Try to duplicate the formatting exactly.

b. On another worksheet, create a statement of cash flows for 2011. Do

not enter any numbers directly on this worksheet. All formulas should

be linked directly to the source on previous worksheets.

c. Using Excel’s outlining feature, create an outline on the statement of

cash flows that, when collapsed, shows only the subtotals for each

section.

d. Suppose that sales were $3,800,000 in 2011 rather than $3,500,000.

What is the 2011 net income and retained earnings?

e. Undo the changes from part d, and change the tax rate to 40%. What

is the 2011 net income and retained earnings?

2. Using the data from the previous problem:

a. Create a common-size income statement for 2010 and 2011. This

statement should be created on a separate worksheet with all formulas

linked directly to the income statement.

b. Create a common-size balance sheet for 2010 and 2011. This

statement should be created on a separate worksheet with all formulas

linked directly to the balance sheet.

3. Download the file named “Chapter 2 Problem 3.xlsx” from the text

support Web site.

a. Fill in the blanks on the financial statements for Winter Park Web

Design with formulas. Some of the formulas will require links to data

given in other worksheets in the workbook.

b. Create a common-size income statement and balance sheet using your

answers from above. Using the techniques you have learned in this

chapter, you should be able to do these statements in less than one

minute each with formatting that is identical to that in the original

worksheets.
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Internet Exercise

1. Choose your own company and repeat the analysis from Problems 1 and 2.

You can get the data from MSN Money at http://money.msn.com/

investing. To retrieve the data for your company, go to the Stocks area and

enter the ticker symbol. Finally, choose Financials and then the statement

type. 

a. On the page that appears, click on the link for the Income Statement

and copy the data to a new worksheet. Reformat the data so that it is

more readable, and insert formulas in place of the numbers where

possible.

b. Repeat part a for the Balance Sheet.

c. Create a common-size income statement and balance sheet based on

the data from parts a and b.

http://money.msn.com/investing
http://money.msn.com/investing
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